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Chapter 1
Introduction

This document introduces the usage of Component Development Environment (CDE) by
creating a software component that is extended using inheritance to make use of a
peripheral driver.

The CDE is an Eclipse plug-in included in CodeWarrior Development Studio for MCU
V10.x, and supported in any Eclipse-hosted platform (Windows and Linux) version 3.6
or later.

The CDE provides the environment to create, edit, and package embedded components
using a graphical interface.

1.1 Overview

An embedded component is a software entity that exposes a specific set of methods,
properties, and events providing an abstraction for peripheral I/O and CPUs. An
embedded component may also encapsulate/package a software stack or RTOS adapter.

1.2 Terminology

* Properties: The initialization state and features supported at runtime by the
component; the properties can only be defined at design time.

* Methods: These are the functions exposed by the component, available at runtime
and are used to set and read the component state or implement behavior.

» Events: These are callback functions exposed by the component to attend to
asynchronous events such as interrupts.

* Driver: A driver contains the source code of all methods and events generated by a
component. Every component, except the CPU, has a driver associated with it.
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* Inheritance: The process that allows using and/or redefining methods and events of

another component.
* Interfaces: Defines the methods and events needed by a new component that uses

the interface.

1.3 Creating embedded component

In this section, you can create an example software component. The software component
computes the parity in a data byte, either even or odd, depending on the component's
configuration. The properties supported by the component are odd parity or even parity
and will add a 1 or a O to the data byte.

1. Select File > New > Embedded Component from the IDE menu bar. The Target
Project page appears. Enter the name of the project or select the existing project and
click Next.

2. The New Component page appears (as shown below). Enter the name of the
component and select the Component type and click Finish.

# New Component Wizard

New Component

Component name:

Cornponent Bype:
{*) Software Component

JRTOS Component
) Interface

Figure 1-1. New component - create new component screen
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The projects are displayed in the Project Explorer and components created in the project
are displayed in the Components view in the CDE folder. You can create or open as
many projects and create or open as many components in the project. You can also create
and import new components/interfaces from Components view.

[ Project Explarer 25 | [= q,:',;_ ¢ ~ — 0O

[SRE=3Cdeproject
= Beans
[== Drivers

1= ss

= b

'T5. Components - cdeproject 53 - Y = 8

= = CDE
[-= BasicProperties

@ cde

Figure 1-2. Project explorer and component view

The Component editor holds the high level information related to the component, such as
author version, the icon to show the copyright information when loaded in Processor
Expert. In the component editor, the project name is different from the component
name.The Component editor is divided into two panels.
* Left panel: displays internal component structure and all related files.
 Right panel: displays an editor for a selected item from component. Editor is also
divided into tabs. The number of tabs depend on the item that is being edited.
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3# cdeprojecticde 52

= @ cde
| Properties
L Tkems
B propertyTypes
o Conskants
m Methods
0 Events
T Types Definition
B Documentation
& Revisions
== Beans
= cde
== Drivers
= Common
= sw
= cde.sre

Mame:

Description:

r*\1'> Buthar:
Wersion:

[ 1eon (16x16:
Types Files:
=

L5 File Wersion:

¥ Options

|DI.DDD

| DEFALLT

| PE,cdeicde

|DI.DDD

¥ Help

» Compiler

Component's Information

Figure 1-3. Component editor

The Component Development Environment provides an independent and specific editor
for each one of the supported features of the component.

Properties editor
Property Types editor
Constants editor
Methods editor

Events editor

Types Definition editor

For more information about each editor and its features, see Component Development
Environment User Guide.

You will understand how to use the editors to add properties, methods, and events.

1.3.1 Adding properties

You can set one of the properties of the component: even or odd parity.

Right-click on the Properties in the Component editor and select Add Property option
from the context menu to open the Properties editor.
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3¢ *cdeprojecticde 2 = O
| | + Basic Settings A
= $ e Fill aut infFormation of method's settings
=3 Properties i Property Type: E:.:..:-Ie.an ves | no
Component Marne @ ttermn Mame: | Property0 |
| P] Propertyﬁl
@ tems Symbol: Property | € symbol; | Property0 |
Bl PropertyTypes T2 GetTextValueIndex: 1
o Constants
i Methods < Hint: | |
Q@ Everts X temLevel: |BASIC bt
T Types Definition
B pocumentation E ReadOnly: O
& Revisions ?2 TvpeChangeable: ¥
== Beans 2 Tvoespechy
= BasicProperties e TYpESpEChamE: |type‘r‘esNo LY | Yalue: |yes W
= cde &
= (= Drivers EJu1_Boclstyle: BUTTON v N
(= Commean U1 DisplayExtraText: | DISPLAY AUTO POSITION v|
= 5w
B cde.sre . U1 Displayn: | TAELE AMD GRAPHICAL VIEW |
£ UI_EnumSkyle: | v|
« Advanced Settings
Fill out information of method's settings
< EditorData: | |
< Editor: | | 3
Settings

Figure 1-4. Properties editor

The ItemLevel item represents the user level at which the item is accessible in the
Processor Expert interface. All users can see it. Some properties are for advanced or
expert users only.

You can provide text in Hint if you wish. This is a context help that pops up over the
property when you hover the cursor.

1.3.2 Adding method

The component exposes only one method that calculates the parity bit based on the
property you set at design time (even or odd).

Right-click on the Methods in the Component editor and select Add Method option
from the context menu to open the Methods editor.

Component Development Environment Getting Started Guide, Rev. 02/2014
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¢ cdeprojecticde 23

+ Basic Settings

- s e Fill aut infFormation of method's settings
+-1 Properties
@ ttems @ Method Mame: Methoda
-5 PropertyTypes < symbal: Methodd
o Constants
S Methods o cetTextwalusindsx:
o i Methodd <> Hint:
Events
T Types Definition Tg IsInAssembler: O
+-[5 Documentation E IsInDefinitiontodule:
& Revisions
¥ .

-G Beans =) ThemLevel: BASIC v
+-[=- BasicProperties ¥ MethodScope: PRIVATE hd
#-[=F cde

36 Drivers TS PublicMethod:
+-[=- Common ?2 ReadOnly: [

H L= s
T— 0 ReturnHink:
14 ReturnType: woid b
¥ selected: YES w
E Tvpehangeable: |
L1 Boolstyle: DROPDOWH | %

Y UL DisplayExtraText: | DISPLAY AUTO POSITION v

¥ UI_DisplayIn: TAELE AMD GRAPHICAL VIEW
Settings | Parameters | cde.dry

Figure 1-5. Method editor

You can configure the methods of the component. The created methods are listed on the
left side, and properties of the selected method are displayed on the right side. To view
parameters of a Method; click Parameters tab of the Component editor.

1.3.3 Component code generation script

The component ultimately generates code. The CDE provides two ways to specify the
generated code, essentially one method at a time, or all at once. The first way is to edit
each method independently. The second option is to edit the whole driver using the file
editor. Note that the entire body of code to be generated is known as a "driver." And the
file that creates that code is a script. You specify the code to be created using the
scripting language: either method by method (independent method editor) or in the driver
file.

1.3.3.1 File editor

To edit the driver, go to the left panel of the Component editor. Navigate to Drivers ->
sw, and double-click the name of the .drv file you want to edit.

Component Development Environment Getting Started Guide, Rev. 02/2014
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Chapter 1 Introduction

3# TEST.componentl [5] companent1.dry &3 = O
3=-Driver pre-generated by the Cowmponent Development Environment -
5= Copyright: 1987 - 2013 Freescale J3emiconductor, Inc. All Rights Reserved.

[
%— WARNING !

-

%— Do not make changes to these lines (if you mwake some changes, you damage this driver)
%— which begins with:

-

%— (-3TARTUSERTYPE3

%¥- %-ENDUIRTYPES

$- /%t END sModuleName. */

— /% MODULE %ModuleName. */
$- %-INTERMNAL METHOD EEG

$- %-INTERMAL METHOD END

$- %-INHERITED EVENT BEGIN

$- %-INHERITED EVENT END

$- %-BW _DEFINITICN 3TART

¥- %-BW _DEFINITICN END

¥- %-BW_INPLEMENT 3TART

¥- %-BW_INPLEMENT END

¥- %-BW_EVENT DEFINITICN START
¥- %-BW_EVENT DEFINITICN END
¥- %-BW_EVENT IMPLEMENT 3TART
¥- %-BW_EVENT IMNPLEMENT END
¥- %-BW_METHOD MACRO3 3TART

- 2RI METHOAT MamDrE BRI

< ¥

Figure 1-6. Driver source code

1.3.3.2 Implement component generation script

Now that you have seen both techniques, use the method editor to implement the driver.

1.

2.
3.

In the Explorer view, double-click the getParityBit method name. Then click
Source Code in the lower tab of the Method editor.

Type the code below into the method body.

Save your work.

Note that this is C code with some %-delimited commands. Those commands are
part of the Processor Expert scripting language. When Processor Expert generates
code, it reads the state of the property and modifies the generated code based on the
if/else condition. This minimizes the generated code.

int i, res = 0;

// Compute parity using shifting and XOR

for (i = 0; 1 < 8; 1i++) {

Component Development Environment Getting Started Guide, Rev. 02/2014
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res = res © (Data >> i);
%$1if %$EvenParity = 'yes'

return (byte) (res & 1); // mask result

%else

return (byte) (~res & 1); // mask result

%$endif
I ErrorDetection : getParityBt ©1 =0
%$-BW_METHOD BEGIN getParityBit A

- ifdef getParityBit

%define! ParData

%define! RetVal

#include Commwon'ErrorDetectiongetParityBit. inc

uined_t = ' Modulellame'% . 3getParicyBit (uintd_t Data)
S (
- %CODE BEGIN

int i, ;=
/f Compute parity using shifting and XOR
o 0; 1 < 8; it+) |
(Data >> i) :

gl %if %EvenParity = 'yes'
recturn (byte) (res & 1) : ff mask result
%else
return (byte) (~res & 1) ;: ff mask result
Sendif

&C UDE_EIID
} W

Detals_. Source code |

Figure 1-7. Entering code using Processor Expert scripting language

Component Development Environment Getting Started Guide, Rev. 02/2014
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Chapter 2
Inherited components

Inheritance allows you to include (and redefine if you wish) methods and events from
another component into your component. This simplifies and speeds up creating new
embedded components. You can even inherit from the platform-independent components
included in the Processor Expert.

The CDE provides two ways to inherit a component.

Select File > New > Other ... New wizard appears. Expand Component Development
Environment and select Inherited Component option, then click Next.

Component Development Environment Getting Started Guide, Rev. 02/2014
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Select a wizard —>
\izards:
|
% Processar Expert MOx-Lite Praject A
% Processar Expert Project
[= General
= ClC++
== Component Developrent Environment
@ Category
@ Ernbedded Cormponent
@ Inhetited Cormponent
= Cvs
= Git
[= Processor Expert n
[= Remate System Explorer
[= RPM
-2 Tacks ¥

©

Figure 2-1. Inheritance wizard

Alternative method is, right-click on the component name or on the Properties in the
Component editor and select Inherit Component....

Component Development Environment Getting Started Guide, Rev. 02/2014
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3¢ cdeprojecticde 2

IEI_Ih.— |

Eﬁ Rename Fz

7 Export
£ | Refresh

Deploy

‘I Inherit Camponent ...

add Driver
S Hevisions
=+ Beans
[= BasicProperties
= cde
=== Drivers
[= Camrmon
= sw
\=| cde.sre

Figure 2-2. Component inheritance

2.1 Inherit component

1. Right-click on the component name or on the Properties in the Component Editor
and select Inherit Component.... A message is shown indicating the current
component must be closed. Click OK.

Component Development Environment Getting Started Guide, Rev. 02/2014
Freescale Semiconductor, Inc.
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mnerit component

I+ Confirm

€ Component cdeproject.cde is opened, it MUST be saved and closed ko avoid
\:,) inconsistencies. Proceed?

| CF; |[ Cancel ]

Figure 2-3. Continuing with the inheritance process
2. Choose the component to be inherited from. Select Init_UART_VARO.

& Inheritance Wizard :; @@

Select Component
Select a component from which this component will inkerit and Fill in the description and the

identifier

Init_MTIM_VARO #  Description for the inherited component:
Init_NFC_YaRr0D _

Init_OPAMP _VARD Init_JART_YARD

Init_PDE_YARD - .
Init_PGA_YARD Identifier For the inherited component:
Init_PIT_¥aRD Init_UART _WARD

Init_RGPIO_WARD .
Init_RNG_YARO [ ] show CPU specific Methods and Events
Init_RTC _WaR1

Init_SDHC _MAROD

Trit_SLCD_WARD
Tnit_SPT_VARD
Init_SPI_VAR1
Init_SRTC_VARD
Tnit_SysTick_VARD
Tnit_TRIAMP_YARD

Init_USBDCD_WARD

Init_LISB_OTG_HS_VARD

Init_UISE_OTG_VARD

|Init YREF WARD na

Figure 2-4. Select component page
3. Select Exclusive usage of components methods and events, and click Next.

For more explanation about each type of inheritance, refer to the CDE User Guide.

Component Development Environment Getting Started Guide, Rev. 02/2014
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* Inheritance Wizard

!

Inheritance Type

Component Usage Mode

Select the byvpe of inheritance

(%) Exclusive usage of component methods and events

) Extend component interface, override or publish components methods or events (true inheritance)
() Shared usage of components methods and events

() Existing interface - use already created interface

Chapter 2 Inherited components

T e

Figure 2-5. Inheritance type page

Select Init method to be inherited to the target component and set the Inherit
settings to Yes, and then click Next.

For more information about each option, see CDE User Guide.

Component Development Environment Getting Started Guide, Rev. 02/2014
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mnerit component

3]
F

Interface Definition

Specify which methods and events are ko be inherited

Inheritance Wizard

o

Details For selecked object (method or ewvent)

Inherit Yes W

Made | ALWAYS_REQUIRED w
Read Only

Scope

Private: method/event is used exclusively
Cwverride: Redefined behavior of the method/event
Published: Method)event is propagated

Cancel

[ < Back ” Mext ] Finish

Figure 2-6. Interface definition page

4. Select Continue without inheriting another component, and click Next.

Component Development Environment Getting Started Guide, Rev. 02/2014
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Chapter 2 Inherited components

i

.~ Inheritance Wizard

Multiple Inheritance

hoose ko inherit from another component or leave the inheriting process

Mulkiple Inheritance
(" Inherit another component

(%) Continue without inheriting another compaonent

List of current inherited Components

Init UART War0:Inik LART WARO

[ < Back |[ Mext > ] Finish

Figure 2-7. Multiple inheritance page
5. The default programming language ANSI C is selected; click Finish.

& Inheritance Wizard

Select Programming Language

Select the languages in which you will implement your new component

Select programming languages

@ [ Finish ][ Cancel

Figure 2-8. Select programming language page

Component Development Environment Getting Started Guide, Rev. 02/2014
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Figure below shows the ErrDetl component with the method Init inherited in the target
component.

3¢ cdeprojecticde 52 = 7
| | = Basic Settings L
= @ cde Fill out information of method's setkings
il Properties
& Items @ methad Hame: | Init
El PropertyTypes © symbal: |Init
o Constants
= i Methods T8 GetTextvaluelndex:
fit Method & Hirt: | This method initislizes registers of the UART module according ko the Peripheral In
i Init
© Events T8 Islnfssembler: [
T/ Types Definition T8 IsInDefiritionMadule:
E Documentation P I
® Revisions e TeemLevel: BASIC w
5= Beans £ methodscope: FUBLISHED
[ BasicProperties
= cde T2 PublicMethod:
= (= Drivers %8 Rreadorly:
(= Cammman D
B sw eturnHint:
= cdeste < ReturnType: B

L selected: ALWAYS W

'ES TypeChangedble:

II =
=X
=N
I|:I

<

X U1_Boalstyle: DROPDOWHN

£ ur_DisplavExtraText: |DISPLHY AUTO POSITION W
< |

Settings | Paramekers | cde.drv

| W

Figure 2-9. Inherited components

2.2 Deploying components

The Deploy operation copies the related component files to the Processor Expert user
path allowing a Processor Expert instance to use the newly created component. It
automatically appears in the Component Library for the selected Processor Expert
instance to which the CDE is connected.

Right-click on the component name and select Deploy option.

Component Development Environment Getting Started Guide, Rev. 02/2014
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4 cdeprojecticde &2

| byvpe Filber bext

E Rename Fz

- L7 Export

£ | Refresh

..... ‘:’ E'EFlll:l ':."

@ €9 Inherit Component ...

Add Driver

IE? BasicProperties
= cde

== Drivers

#-E Common
IE? -

- |=| cde.src

Figure 2-10. Deploy component screen

Verify the path is correct and click Finish.
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-

# Deploy Component Wizard

Deploy Component,

Set User Directory as Default

Directory to deploy: Browse, .,

Files ko deploy:

B _ornponents
[=- cde
Beans
Drivers
additional Files

Reemove File

[ Einish l [ Cancel

Figure 2-11. Deploy component wizard

NOTE
Under Windows > Preferences > Processor Expert > CDE
Preferences, select the checkbox labeled Auto Deploy
Component when saved. When selected, this option auto
deploys the component every time it is saved.

Component Development Environment Getting Started Guide, Rev. 02/2014
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& Preferences |Z|E

| | Component Development Environment =T -
e I
CFQ—T—T Saving Dialog
Dioxygen Enable Save Dialog
Help Auto Deploy Component when saved

IAR Embedded Workbench Se D:'\Profiles\all Users\application Data\Processor Expert\PEXDRY _PES_3)
InstalfUpdate

Myl Debug Level

(] ] ] ] ] ] ]

Processor Expert [ |Enable Processor Expert Components Debug Yerbose Maode

omponent Development

[]show Symbols in property tool-tips
aeneral

Paths
Remake Systems
RuniDebug
Team
IUsage Data Colleckor

] ][]

[ Restore Defaults ] [ apply ]

|
|

S

Ok H Zancel ]

Figure 2-12. Auto deploy preferences dialog
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Chapter 3
Exporting and importing components

CDE allows you to import or export component or interfaces of the selected components.

This section explains:

* Exporting components
* Importing components
« HTML Help

3.1 Exporting components

The Export operation generates an installable package for distribution. This package can
be imported into other Processor Expert instances, for example, on a separate computer.

1. Right-click on the component name and select Export option.

Component Development Environment Getting Started Guide, Rev. 02/2014
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@ cdeprojecticde B2

| kvpe Filker kexk

Rename FZ

r_7 Export

o # | Refresh

e 3 Deploy

-
---EI 9 Irherit Component ...

== B
# (= BasicProperties
= cde

== Drivers

E:- Common
[E:- s

El o —

Add Driver

Figure 3-1. Export component screen
2. Click Browse ... and select a directory destination.
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5

.= Export Component Wizard

Export Component Fles

Component(s) ko be exported to package.

Package name: | | Browse, ..

Files to package:

[EE TEST . component 1
Beans\component1icomponent 1.bean
Beansicomponent1icomponent1.chg
Beansicomponentlicomponent1.cns
Beansicomponent1icomponent 1. hkml
Beans\component1icomponent1.tps
Beans\component1component 1. usk
Beansicomponentlicomponent 1Events . html
Beansicomponent1icomponent 1Methods bkl
Beansicomponent1icomponent 1 Properties bl
Beanscomponent1icomponent 1 ser Twpes, hkml
Beans\component1icomponent1_b.qgif
Beansicomponent 1 Init_JART_YARD.ink
Drriver s\ Commoncomponent 1 Abstract.inc
Drrivers\Commonicomponent 1EventD.inc
Drriver s\ Commonicomponent 1 MethodO.inc
Drriver s\ Commonicomponent 1 Method1 inc
Drriver s\ Commantcomponent 1 Setkings.inc

FCiwin 1w = b L

Package comment

Package from componentis):
TEST.componentl wersion 01,003
Package Created Thu Aug 08 14:27:51 IST 2013

Cancel

Figure 3-2. Export component files screen
3. Name the package and click Finish.

You can also import the .upd file the component will appear in the Component
Library view.

Component Development Environment Getting Started Guide, Rev. 02/2014
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3.2 Importing components

You can import the component or interface into your current project and also can import
the component from package. This package can be imported into other Processor Expert
instances, for example, on a separate computer.

This topic explains:
e Import component or interface
* Import from package

3.2.1 Import component or interface
You can import the component or interface into your current project.
To import component or interface:

1. Select the project in which you want to import the component or interface. Right-
click on the project name and select Import option. The Import screen appears.
Select Component Development Environment - > Import Component/Interface
option.

Component Development Environment Getting Started Guide, Rev. 02/2014
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Select

Select an import source:;

= zeneral

= Cic++

[= Codewarrior

== Component Development Environment
@ Impart Component)Interface
@ Import From Package

= cys

= Install

[= Processor Expert

[= RunDebug

== Software Analysis
= Trace

[= Team

[= Other

@

Figure 3-3. Import screen
2. Select Next. The Target project screen appears. Select the project where you want
to import the component.

Component Development Environment Getting Started Guide, Rev. 02/2014
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(ES]

.~ Import Component Wizard

Target Project

Select existing project for component oF enker name of a new ane,

Project narme: | MainProject

Select Project

@ [ < Back ]MExt} | Finish

Figure 3-4. Target project screen
3. Click Next. The Select component for import screen appears.

Component Development Environment Getting Started Guide, Rev. 02/2014
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3]

.~ Import Component Wizard

Select component for import

[ ILirked From Processor Expert components folder into project
(%) Seleck From Components Library
) Browse For Folder

© T e

Figure 3-5. Select component for import screen

Select the required option.

* Linked from Processor Expert components folder into project - if this
checkbox is selected, the imported component or interface in the project will be
linked from PEx directory

* Select from Components Library - if you want to select the component or
interface from the Component Library

* Browse for Folder - if you want to select the component or interface from your
folder

4. Click Next. The Select component/interface from Component Library screen
appears.
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|0
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Figure 3-6. Select component/interface from Component Library screen
5. Select the required component or interface from the List of Components or List of
Interfaces. Click Finish. You will see that the selected component is imported into
the current project.
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2 CIC++ - MainProject/MainProject - CodeWarrior Development Studio |'__||'E|fz|
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2 Documentation Icon: | |
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» Options
b Help
» Compiler

3 *
Component's Information
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0 items
! Descripkion Resource Path Location Type

Figure 3-7. Component imported into the project screen

3.2.2 Import from package

You can import the component from package. This package can be imported into other
Processor Expert instances, for example, on a separate computer.

To import component from package:

1. Select the project in which you want to import the component or interface. Right-
click on the project name and select Import option. The Import screen appears.
Select Component Development Environment -> Import from Package option.
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(= Code'Warrior
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Impark From Package

= s

== Install
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[== RunjDebug
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[== Team

[== Other

©
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Cancel

Figure 3-8. Import from package screen
2. Select Next. The Import component screen appears.
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3]

.= Import Component from UPD Wizard

Import Component
Get Campanent(s) from package

Select File: | | B
| ru:uwse...l
Files in package:
=Nrdecomp

Beans
Driver
Additional

Save File Lisk

Package comment:

® Mext = [ Einish H Zancel ]

Figure 3-9. Import component screen
3. Click Browse to search for the package from which component can be imported.
4. Click Finish. You can see the Components view and Project Explorer that the
required component is added.
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Figure 3-10. Component is added from package screen

3.3 HTML help

The CDE generates several HTML help files based on the methods and properties hints
entered during design time. You will find these files in the Beans folder of the
Component editor.
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Figure 3-11. HTML help files screen

To view HTML editor, right-click on the component HTML file and select Open With -
> Default Editor option from the context menu.
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Figure 3-12. HTML editor screen
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